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Introduction 
(Words in italics explained in Glossary)  
 
Features 
 
This program allows the user to: 
 
• Get the ECU serial number for the issuance of the software key to allow the programs to 

work on the owner’s bike; 
• Backup ECU contents (Sagem ECU only); 
• Read the current tune from the bike (Sagem ECU only); 
• Download the factory tunes to the bikes ECU; 
• Download third party tunes; 
• Modify the current tune in the ECU; 
• Save tunes and exchange them with other bike owners who own this TuneEdit software; 
• Make changes, small or large, to the fuel and ignition tables; 
• Change the ECU controlled rev limit; 
• Change thermo fan turn on/off point (currently Sagem ECU); 
• Apply Power Commander (PCIII) trim maps over the standard tune; 
• Use the DynoJet Tuning link software to remap ECU; 
• Export the tune tables in MS Excel format for analysis; 
• Get real time information from the ECU as the bike is running. 
 
 
 



Installing TuneBoy/TuneEdit Software 
 
On receipt of the TuneBoy Software CD- 
  
• Start up PC/laptop, insert the CD into the CD-rom drive.  Slide the drawer closed!   
• Wait a few seconds and the “install program” should start running by itself.  Install 

information should begin to appear on your computer monitor.  (The install is self-
starting after the CD drawer has closed.) 

• Read the instructions, particularly the disclaimer, and allow the software to install.   
• It is recommended that the default directory selection and names be used so that any 

future problems will be easier to fix and support easier to understand. 
 
NB: If for some reason the install program does not begin to extract automatically, 
use Windows Explorer to open the directory on the CD-rom, typically the D: drive.  
Locate the file “Setup.exe.”   Double click on this file to cause it to execute and the 
install process should then start.   
 
 
Re-Installing TuneBoy Software / Installing Upgrades  
 
Upgrades will be forthcoming both to add new features and to any fix bugs that may become 
evident.  When putting the upgrades in place please take note of the following guidelines: 
 
• Always use the Windows uninstall function to remove the old installation.  Software 

incompatibility problems have resulted from simply exchanging executable files. 
• Always use the install wizard supplied with the program to install the program.  Files 

will be put in the proper place on your hard drive and system files will be upgraded. 
 
In the event that you have never uninstalled a program, go through these steps: 
 
• Go to the very lower left of your Windows screen, and click your mouse on the START 

label.  A pop-up menu will appear. 
• Go up to the SETTINGS selection and click it. 
• Slide the cursor to the right to CONTROL PANEL, click it and a large screen/window 

will appear. 
• Find the icon for ADD/REMOVE PROGRAMS and double click it. 
• Search down through the programs list until you find “TuneBoy”. Select it, and then 

select add/remove.  Windows will then prompt you through the process to complete 
the uninstall. 

 
 
Installing TuneBoy/TuneEdit from Media other than a CD 
 
If you have received TuneBoy Software on media other than a CD, such as a zip file from a 
website, follow these directions: 
 
• Place the file or files into their own temporary directory on your hard drive. 
• If the files are zipped, use Winzip or an equivalent decompression program to extract the 

individual files from the archive. 
• Find the file named setup.exe and double click it to start it running. 



• Let the install wizard guide you through the process, paying particular attention to the 
disclaimer. 

 



 
Installing USB device drivers (USB cable only) 
 
If you have the new TuneBoy USB cable you will need to install the device drivers for the 
cable. follow the steps below to install the drivers 
 
Connect the device to a spare USB port on your PC. 
This will launch the Windows Found New Hardware Wizard. The following screen will be 
displayed. 

 

 
 
Select “No, not at this time” then click "Next >" to proceed with the installation. 
 



 

 
 
Select “Install from a list or specific location (Advanced)” then select “Next” to continue. 
 



 
 
Select “Search removable media (floppy, CD-RPM…)” then click “Next to continue with the 
install. 
 
 



 

 



 
 
Select “Continue Anyway” 
 



 
 
Select "Finish” 
 
This process will repeat a second time for a device called “USB serial port” follow the same steps 
outlined above. 
 
Your TuneBoy cable is now ready to use. 
 
 



 

Getting Started  
 
Getting the ECU Serial Number to Obtain Software Key: 
 
Connect the TuneBoy cable to the OBDII diagnostic connector (usually located under the 
seat of the bike).   
 
Connect the other end of the cable to either a laptop or PC on which the TuneBoy software 
has been installed (Install the software before you connect the cable).   
 
Double click on the TuneEdit icon on the desktop and wait for the program to load. 
 
The first time you start TuneEdit it will display the following popup. 
 

  
 
Click “OK” ,this will display the following screen. 
 



 
 
You need to open the correct tune for your bike, TuneEdit requires this so that it knows what 
type of ECU it needs to talk to. 
You should have all the tunes in “C:\Program Files\TuneBoy\TuneBoy\Tunes\” you will also 
find the tunes on the CD and on the www.tuneboy.com.au web site. 
 
 
Turn the bikes ignition switch to ON and position the kill switch to RUN.   
 
NB:  These conditions must always be met whenever the TuneBoy or TuneEdit 
software is used to connect to the bike.  The PC or laptop will not be able to 
communicate with the bike if these two switches are not in the proper place.  Do not 
start the bike for this operation.  If you wish to conserve battery power the headlamp 
fuse can be pulled out. 
 
The LED on the cable should flash and you should see a message saying “Authentication 
failed” at the bottom of the screen and the following popup will be displayed. 



 
 
Copy the ECU type and serial number exactly as it appears.   
If you purchased your TuneBoy from www.tuneboy.com.au then you should Email this to 
support@tuneboy.com.au for your TuneBoy/TuneEdit key to be generated. 
If you purchased from another web site you should contact them for your key. 
The key will unlock the functionality of the TuneBoy/TuneEdit software.  You should receive 
the key within 24 hours.   
 
NB.  The key is generated from the bikes ECU serial number.  It is locked to that bike. 
 
When the software key is received, select the Properties screen again.  Enter the key in the 
box labelled “New Key.”  Then click the “Add” button.  This key will now appear in the 
software/download keys list (see below).  Any number of keys can be added to this list. 
 
You must now click the “Save” button to exit the Properties screen and save the new key.   
 
 
 

  
 
 
You can now use the TuneEdit and TuneBoy software. 



 
NB: The Properties screen can be accessed from TuneBoy or TuneEdit and the data is 
stored in the same part of the system registry. 
 
 
Setting the Serial port: (Only required if serial number not 
displayed) 
 
If you don’t get the “Authentication failed” message you should “Options” (at the top of the 
TuneEdit screen - grey coloured region reading File…Edit…View…Tools…Options…Help). 
 
Select “Properties.”  The following screen will be displayed. 
 

 
 
By default the Serial Port (communications port) is set to COM1.  Ensure that the selected 
port is the port that you are using to connect the cable to the bike.  Change this if necessary.   
 
If the TuneBoy cable shows up as “TuneBoy Cable(COMnn)” then the cable type should be 
set to 2. 
 
Tuning Link Serial Port is only used when you use the Dynojet Tuning Link software. 
 
On the same screen there is a variable called “wait time”.  This is set by default to 30.  
Only change this if you have trouble getting the TuneBoy or TuneEdit program to 
connect to the bike.  For more information on “wait time” see Troubleshooting section. 
 
Click the “Save” button to close the properties screen. 



 
 
Once you have the correct tune loaded you should close the TuneEdit program and start it 
again.  Make sure the bike is connected. 
 
The LED on the cable will flash and you should see a message saying “Authentication failed” 
at the bottom of the screen.  This is normal. 
 
Now click on the “Tools” menu.  In the middle of the pop-down menu there is a selection 
titled “Get ECU Serial Number.”  Click on this.   
 
The screen below should appear.  This shows the ECU type and the ECU’s serial number.   
 
 

 
 
Copy the ECU type and serial number exactly as it appears.   
If you purchased your TuneBoy from www.tuneboy.com.au then you should Email this to 
support@tuneboy.com.au for your TuneBoy/TuneEdit key to be generated. 
If you purchased from another web site you should contact them for your key. 
The key will unlock the functionality of the TuneBoy/TuneEdit software.  You should receive 
the key within 24 hours.   
 
NB.  The key is generated from the bikes ECU serial number.  It is locked to that bike. 
 
When the software key is received, select the Properties screen again.  Enter the key in the 
box labelled “New Key.”  Then click the “Add” button.  This key will now appear in the 
software/download keys list (see below).  Any number of keys can be added to this list. 
 
You must now click the “Save” button to exit the Properties screen and save the new key.   
 
 
 



  
 
 
You can now use the TuneEdit and TuneBoy software. 
 
NB: The Properties screen can be accessed from TuneBoy or TuneEdit and the data is 
stored in the same part of the system registry. 
 
 



Troubleshooting 
 
If you have difficulty in getting the ECU serial number, perform the following checks: 
 
• Is the ignition ON and the kill switch in the RUN position? 
• Do you have the correct tune open for your model bike, have a look at “Edit” menu and 

select “Notes” to check this. 
• Is the cable properly connected to the bike and to the USB or serial port on the 

PC/laptop? 
• Is the bike’s battery properly charged?  The cable and ECU run off the bikes battery and 

a low battery could cause communications problems. 
• Is the serial port (COM port) selection under Properties set to the desired COM port? (If 

the LED does not blink you may have the wrong port selected or the port may be 
disabled in the BIOS of the PC). 

• Are any other applications running on the PC that could interfere with the COM port? (A 
message will be displayed to warn you if the port is in use) 

• If you get the message 

We recommend that you change the COM port that is assigned to the TuneBoy cable, 
this is done with windows device manager, change the port to COM20 then change the 
properties in TuneEdit to match this setting. 

 
If these are all OK, open Tools…Properties and change the “Wait Time”.  At first make it 
lower, dropping by increments of 5 and checking to see if the program works with each new 
value.  (You can go as low as 0.)  Try the “Get ECU Serial Number” as a test.   
 
This Wait Time parameter depends on the PC itself and it is not possible to predict in 
advance what it should be.  Thirty (30) works on most machines but it may have to be 
adjusted. 
 
The Wait Time may also need to be changed if a download fails mid-stream.  In most cases 
the number will need to drop by 5 to allow you to restart the download.  



 
Backing up the Contents of the ECU (Sagem ECU only) 
 
This feature allows you to take a copy of the contents of the ECU before you make any 
changes with the TuneEditing software.   
 
At the moment the only way to restore the backup is to send the file to 
support@tuneboy.com.au and we will convert it into a tune file that TuneEdit can download.  
 
If the tune in the ECU is a standard Triumph tune, the backup is not required as you can 
download all these tunes from the NET.  To check what tune is currently loaded, use the 
“Read map from ECU” under the “Tools” menu). 
 
To backup the ECU, go to the “Tools” menu. 
 
Select “Backup ECU Contents”.  (Remember, the bike must be connected to your PC/laptop, 
the ignition ON and the kill switch in the RUN position.)   
 
The following screen will be displayed asking for you to give the backup file a name.  
 

 
 
When you click the “Save” button, the program will connect to the ECU and a message will 
appear on the bottom of the screen saying “Backup in progress” and the progress bar will 
start filling in. 
 
When the backup is complete a message box will pop up saying “Backup Complete”.   
 
At this point you must turn the ignition off and on before anything else can be done with the 
ECU. 
 



Loading a Tune into the ECU 
 
Tunes can currently be downloaded from 
http://www.tuneboy.com.au/TuneDownloads/Tunes.html .  This site has all the standard 
tunes as well as custom tunes for different bike setups. 
You can also use the “Read map from ECU” option under the “Tools” menu (Sagem only).  
This will read the maps currently in the ECU and display them on screen.   
 
This data can be saved to disk and/or modified and reloaded into the ECU.  This option only 
reads the map data from the ECU and as such can only be loaded back into the ECU if the 
program in the ECU is unchanged.  Tunes downloaded from the web site contain the 
program and map data and can be loaded regardless of which program is currently in the 
ECU.   
 
NB:  If you have any non-standard tune in the bike now, it will be lost and not possible to 
recover once another tune is loaded into the bike.   Therefore it is suggested that you backup 
the ECU beforehand or read and save the current tune. 
 
You can check what tune is loaded into the bike by using the “Tools” menu and selecting 
“Identify map in ECU”. This will try to work out what tune is currently loaded into the ECU. 
 
Start by downloading the correct tune for your bike from the Internet or from the Tunes folder 
on the CD.  Use the same folder you installed the software to.  This should be “c:\program 
files\tuneboy\tunboy” by default.  Open the tune with the TuneEdit program.   From the 
menu bar at the top of the TuneEdit screen select File, and then “Open Tune file.”  The 
following screen will appear: 
 

 
 



When you click on a Tune file it will display the notes from the file in the “Tune Notes” field at 
the bottom of the screen (e.g. exhaust type, bike model.).  This makes it easy to find the tune 
that you want to load. 
 
Once you have selected a tune, click the “Open” button to load the tune into the TuneEdit 
program. 
 
 
The default directory, C:\Program Files\TuneBoy\tuneboy, is the best place to store the 
tunes. 
 
Once the tune file has been opened, the zeros in the fuel tables will change to non-zero 
values and the download button will change to yellow.  This indicates that the tune is now 
ready for downloading.   
 
If you only see the fuel % trim table and Ignition trim table then you should go to the 
View menu and select Advanced user.  The software is set to Novice by default. 
 
You should now see something like this: 
 

 
 
 
Ready the bike by ensuring that the ignition switch is ON and the kill switch is in the RUN 
position.   
 
NB:  The bike cannot be running when downloading a tune. 
 
When you click the download button the following screen will be displayed: 
 



 
 
 
NB:  If you are not sure that the changes you have made are safe then you should 
NOT proceed with the download.  Click “No”.  If you are sure that your changes will 
not cause engine damage then click the “YES” button to start the download. 
 
If you do not want this message to be displayed before each download you can remove the 
tick from “Show this warning next time”. 
 
Before you can start a download to the Keihin ECU you must wait for the connection to the 
ECU to be established.  You will see the Authenticated message when this is complete and 
the Download button will change to yellow. 
 
If the download fails to start (“Download timed out” message) you must wait for the 
Authenticated message before you click the Download button to try the download again. 
 
Once the download starts, the progress bar on the bottom of the screen will start to fill up 
with blue squares to indicate how far the download has progressed.  See below: 
 

  
 



When the progress bar reaches the end a message box will be displayed indicating that the 
download has completed.  You should also hear the fuel pump prime at the end of the 
download. 
 
The download should take about three minutes the first time you download a tune then 15 to 
30 seconds if you are only making changes.   
 
 
 
Troubleshooting 
 
First, see steps in previous section. 
 
Keihin ECU 
 
If the download fails part way through, use the following steps: 

• Close TuneEdit software, 
• Start TuneEdit again, 
• Wait for the Authenticated message, 
• Click Download again, 
• If the Authenticated message is not displayed you should use the Tools menu and 

select Recover from failed download, 
• This will do a full download of the unmodified tune.  

 
When you use the Recover from failed download you must do a normal download in order to 
put your changes into the ECU. 
 
 



About the Tables 
 
 
Note: By default the TuneEdit program will start up in Novice mode. In this mode only the 
trim tables and diagnostics will be displayed. If you want to have access to all tables you 
need to select “Advanced User” in the “View” menu. 
 

 
 
Above is the main fuel table. 
 
The Keihin has F1,F2,F3 for individual cylinders, the Sagem has Fuel Map for all cylinders.   
 
To view the other tables click on the tab with the name of the table you want to view (for 
example clicking on the “Ignition” tab will switch to the Ignition table.) 
 
The Fuel table is made up of 16 ,24 or 32 RPM increments (dependant on tune) and 16 or 
20 throttle position increments (TPS). 
 
The Ignition table is made up of 16 or 32 RPM increments and 16 or 20 throttle position 
increments (TPS). 
 
The Ignition table is in degrees before-top-dead-centre. This table is indexed by calculated 
engine load and revs per minute. 
 
The Keihin ECU uses several Ignition tables, these are I1, I2, I3 and I4. 
 
The fuel table is in milligrams of air. This table is indexed by throttle position and revs per 
minute. 
 
The bottom rows of the tables on some tunes are not used as they are outside the range of 
the throttle position sensor (as indicated by “N/A”.) 
 
The numbers in the fuel table equate to the amount of air the ECU thinks that a cylinder 
takes in during one engine cycle.  A bigger number will make the ECU deliver more fuel and 
a smaller number less fuel.  This is because it thinks the cylinder has more air in it. 



Tunes for the Keihin ECU also have tables L1,2,3.  These tables are used instead of the 
main fuel tables when the throttle is below 6%. These tables are indexed by manifold 
pressure. 
 
The yellow box on the table shows the current position in the map that is being used to 
calculate fuel or ignition (depending on which table you are looking at).  This can be one, two 
or four squares depending on the current throttle position and RPM.  When more than one 
square is yellow the ECU will interpolate between values to come up with the correct value 
for the current position.  This means that even though you only have 24 RPM increments the 
ECU will calculate the fuel or ignition value down to 1 RPM. 
 
The “Fuel % trim” table contains percentage trims to be applied when you load the tune into 
the ECU.  (This will be explained further on.) 
 
The ignition trim table contains values to be added to the ignition and ignition limit tables. Be 
very careful when changing ignition advance as severe engine damage can occur if 
the numbers are advanced too far. 
 
Sagem only: The ignition limit table is used to place a cap on the ignition advance to 
prevent detonation due to excess ignition advance, the reason this is required is because the 
values in the ignition table are only used as a starting point for the calculation of ignition 
advance, corrections to these values are made to take into account environmental 
conditions. The ignition limit is used to make sure that these corrections do not over advance 
the ignition. 
 
The A/F 1 table is used to calculate the ratio of fuel to be added to the air in the cylinder. 
This has nothing to do with oxygen sensors in the exhaust and applies even if your motor 
does not have a sensor.  The way the A/F 1 table works is simple. If the ECU calculates from 
the fuel table that the motor has 300.0 milligrams of air and the target air/fuel ratio is 13/1, 
then the ECU needs to add 23 milligrams of fuel.  The actual injector pulse time is calculated 
using the known value of the injector flow rate.  This can be changed in some of the tunes 
under the tune constants menu item.  The A/F 1 table is indexed by calculated engine load 
and revs per minute. 
 
Sagem Only: The A/F 2 table works the same as the A/F 1 table when the motor is at full 
load.  Full load and full throttle are not the same.  At low revs full engine load is reached at 
part throttle. The reason for this is because at lower revs even part throttle is to fill the 
cylinder with air enough (given the time available).



Changing Fuel / Ignition Values 
 
Changing a fuel or ignition value is as simple as dragging out a square with your mouse and 
pressing a couple of keys.  No need to pull anything apart - you don’t even get your hands 
dirty! 
 
Example: If you wanted to change the amount of fuel between 2000RPM and 2600RPM 
between 40% throttle and 100% throttle, all you need to do is move the mouse pointer over 
the 40% @ 2000RPM square, click the left mouse button and (while holding the mouse 
button down) move the mouse pointer up and over to the 100% @ 2600RPM square and 
release the mouse button.  This will change the colour of the squares to green.  See below: 
 

 
 
Now when you press the page up (PGUP) or page down (PGDN) key on your keyboard, all 
the squares that are green will be incremented or decremented. The amount they will move 
is 0.1.  Holding the shift key will make the increment/decrement value 1.0 . 
 
Once you have changed a value the background colour of the square changes to turquoise 
so you can keep track of the areas you have made changes to.  This indicator is cleared 
when you exit the program, load a new tune or download the tune to the ECU.  
 
The values in the tables can also be viewed graphically - it is often much easier to see the 
“bad” area’s of the map with this tool. The graph is displayed by selecting “Show 3D graph” 
from the “View” menu or by pressing the G key on your keyboard.  The G key and menu item 
will also then hide the graph if pressed/selected again. 
 
The red lines in the graph intersect at the current cell in the table.  The arrow keys move 
around in the graph and the PGUP/PGDN and Shift-PGUP/Shift-PGDN work the same as 
they do in the tables. 
  



 
 
 
If you would rather change the fuel table values by percentage rather than by simple 
incrementing, there is a table provided called the “Fuel % Trim” table.  Select the tab for 
“Fuel % Trim” (note that all the entries are zero) use the mouse click-and-drag technique as 
discussed above to select a block of cells.  Now use the PGUP and PGDN keys to change 
the value, for example, to plus 5 %.  If you were to download this now modified tune to your 
bike you would be running 5 percent richer during the time that the bike is running between 
the throttle and rpm range you had selected.  If you had selected the entire table, you would 
be running 5 per cent richer all the time. 
 
You can also change the ignition table, but please keep in mind that changes to the 
ignition table can profoundly affect the performance and well-being of your engine.   It 
is extremely important that you know what you are doing before changing your engine 
timing. 
 
There is a trim table associated with the ignition table, but it is NOT a percentage table.  It 
affects the timing in an incremental fashion - not by percentage.  It allows you to add or 
subtract from the ignition timing in fractions of a degree increments.  Selection works as in 
the fuel tables except that the increment for the PGUP/PGDN is always by the amount 
determined by the raw values in the tune.  Some tunes are in .625 degree increments some 
in .975 degree increments.  The table numbers will move according to the internal table 
increments. 
 
 
Changing Air / Fuel Tables 
 
A tune also contains air/fuel target tables (A/F Targets.)  These tables are used in calculating 
the amount of fuel to squirt from the injectors.  These tables are numbered A/F 1 and A/F 2.  
See below: 
 



 
 
The A/F 1 target table has 16 rows while the A/F 2 has only one row.  The first table (AF 1) is 
used for part throttle settings.  The second (AF 2) is used when the ECU considers the bike 
to be under full load.  
 
You can see from the screen shot above that the air fuel ratio that the ECU is trying to reach 
is very different depending on engine load and revs per minute. 
We suggest that you set the air/fuel targets to about 13 to start with as this is a good value 
for power.  This may vary from one engine type to another, for example the Aprilia works 
better with 12.5/1. 
 
Once the A/F targets are set you should adjust the fuel table so that the exhaust gas 
readings on the dyno match the targets.  Doing this will ensure that the ECU makes the 
correct adjustments for environmental changes. 
 
On some tunes there is another Air/Fuel target value.  This is a value used in idle situations 
and under very slight throttle opening.  This value is accessed via the “Tune Constants” 
under the “Edit” menu.   
 
Example: You can see that the value for this tune is 14.5/1.  If you change this value the bike 
may never go into closed loop mode* and the idle may become rough.   
 
*(See next section for explanation of closed loop mode.) 
 



 
 
The tune constants screen is different on the Keihin ECU and contains the final drive ratio, 
idle speed, speed limiter (Rocket III only) and options to disable the O2 sensor. (See below) 
 

 
 
This can be used to correct the 7% speedo error built into the system.  It can also be used to 
adjust the speedo when you make changes to the final drive ratio (bigger or smaller 
sprockets). 
You can change the value directly by clicking on the field and hitting the PGUP or PGDN 
keys. 
To help with wheel speed changes we have included a calculator to do the changes. 
Enter the standard front and rear sprocket size (number of teeth) and the percentage of 
speedo error, then click the calculate button.  
This will adjust the wheel speed constant. 
For the Rocket III put 1 in all the sprocket fields. 



 
Closed Loop Mode 
 
Many bikes now come with O2 sensors to allow the ECU to adjust the fuel mixture to provide 
smooth running under light throttle conditions. 
 
The ECU can only go into closed loop mode when the target air/fuel ratio is 14.5 – 14.7 to 1. 
Looking at the above air/fuel target table and the tune constants, you can see that the only 
time this tune will run in closed loop is at idle and very small throttle openings. 
 
For the bikes with the Keihin ECU you can disable the closed loop mode by removing the 
tick from the “O2 sensor fitted” box 
 
Idle Table 
 
The “Idle table” contains the target idle speed vs. engine temp.  This table is also a single 
row table.  (Sagem ECU’s) 
 
The idle speed for bikes with the Keihin ECU is in the tune constants screen. 
 
Using the example below, if the engine temperature was 44 degrees C the bike would idle at 
1425 RPM.  At 84 degrees C the bike would idle at 1200 RPM.   
 
NB: If you change these you may cause a stalling problem. 
 

  
 
 
SEC (Secondary Throttle Table) 
 
The SEC table shows the position of the secondary throttle plate for each gear and RPM 
location (See below). A value of 0 is fully closed and a value of 255 is fully open. 
The Rocket III uses this table to limit power in the first three gears. 
If you change all values to 255 you will have full power in all gears.   
 



 
 



How Trim Tables Are Factored Into The Download 
 
The software takes all the raw values that are in the fuel tables and applies the percentages 
that are contained in the Fuel % Trim table and loads the resulting number into the bikes’ 
ECU.   
 
Example: If you had 2500 in a certain cell in the fuel table, and you had 10 % in the 
corresponding cell in the trim table, the value loaded into the bikes’ ECU would be 2500 plus 
10 % (250).  Therefore, 2750 is what would be going into the ECU for that cell.  Likewise, if 
the ignition table had a cell with 29 degrees in it and the trim table had 3 degrees, the value 
going into the ECU would be 32 degrees. 
 
If you were to save the tune and then recall it, the fuel and ignition tables would still have 
their uncorrected values in them and the trim tables would contain the modifications that you 
had decided on.  If you want to commit the trim modifications to the fuel and the trim tables, 
then there is a mechanism provided for you to do this.   Under the “Tools” menu there is an 
option “Commit Trims to Main Tables.”  If you click on this, the percentages that are 
contained in the Fuel % Trim table will be applied to the Fuel table and the values in the 
Ignition Trim table will be added to the Ignition table.  The Fuel % Trim table and Ignition 
Trim table will then be zeroed out. 
 
You do not have to “Commit” the trims to the main tables to have the changes put into the 
download.  The TuneEdit software will do these calculations for you.   
 
There is an advantage to working with the trim tables and not changing the main 
tables in that you have a better feel for how far you have deviated from the baseline 
tune that you are working from.  We would suggest committing to main tables only 
after the tune has been refined. 



Saving a Tune 
 
To save your modified tunes, select the “File” menu, select “Save Tune.”  Make sure you 
change the file name of the new tune to something meaningful and do not write over 
your standard tune.  We also suggest that you change the Tune Notes.  See “View”, “Edit 
Notes” menu.  This way you can see the relevant information about the tune when you go to 
load the tune in the future. 
 
The tune will be saved exactly as you have set it up, including the rev limit.  
(Try to save to a new file every time you make a change - this makes it easy to go back a 
step or two.)  
 
At any time you can go back to the standard tune (provided you have saved a copy) and all 
changes will be cancelled out. 



Using TuneEdit With a DynoJet Dyno and the Tuning Link 
Software. 
 
The TuneEdit software has the ability to interface between the bikes ECU and the Tuning 
Link software as used on a DynoJet 250 dyno.   
 
For this to work you need a laptop with two serial ports (one can be a USB to Serial adapter) 
and a null modem cable (The null modem cable can be purchased from any PC or 
electronics store). 
 
How it works. 
This option works by communicating with the bike using the TuneBoy cable and with the 
Tuning link software on the second serial port (with null modem cable).  When the Tuning 
Link software asks for the map, the TuneEdit software provides it with a zero trim map.  
Then, as the tuning link software asks for throttle and RPM info, the TuneEdit software 
provides this info based on the map locations in the Triumph map.  The reason it does not 
report the actual throttle and RPM info to the Tuning Link software is to force the Tuning Link 
software to recommend change at the locations that match the Triumph map rather than the 
normal Power Commander© map positions. 
 
To enable this option you need to make sure that the “Serial port 2” is set correctly in the 
“Properties” menu, then select “Start Power Commander Emulation” under the “Tools” menu.  
This will open the second serial port and prepare to relay information.  Once this has been 
started you can adjust the throttle points used by selecting the “Fuel % Trim” table.  When 
this table is displayed nine of the rows will have a red background.  These are the rows that 
will be used to match the Power Commander© map locations.  These rows can be changed 
by moving to a row (with the arrow keys or by clicking on the row) and hitting the P key.  
Only nine rows can be selected at any time and the 0 and 100 percent rows must always be 
selected.  If nine rows are selected you need to deselect a row with the P key before a 
different row can be selected.  By default the rows are arranged to give a good spread 
across the throttle range. 
 
Once the emulation is started the dyno operator can use the Tuning Link software as they 
would with the Power Commander©. 
 
After each throttle run, the map is updated by the Tuning Link software.  These changes will 
be placed in the “Fuel % trim” map on the rows selected in red.  You should only do one 
run on each throttle position as a download is required to commit these changes to 
the ECU.  The Tuning Link SW thinks the changes have been made after the 1st run (which 
is what it normally does thinking it’s talking to a PCIII).  Once a number of runs at different 
throttle positions have been made you should stop the engine, Save the tune and then use 
the “Tools” menu to “Commit trims to main tables”.  This will take the suggested changes 
from the Tuning Link software and apply them to the fuel map.  Next you should download 
the map to the ECU. 
 
At this point your ECU will have the changes from the dyno runs. 
 
If you plan to make more dyno runs you should start again with a zero trim map on Tuning 
Link software and the TuneEdit software. 
   



 
 
Example of selected rows 
 



What if the download fails ? 
 
 
Definition of a failed download: 
If the download has started (progress bar has some squares filled in) and the cable falls out 
or power to the ECU is dropped (kill switch or key turned off), this is considered a failed 
download. 
 
When a download starts the ECU is put into “re-program mode”.  At the end of the download 
it is switched back to “run mode”.  While it is in re-program mode the bike can’t be started 
and the ECU will not respond to any diagnostic requests. 
 
What do I do to recover? 
1)  If the cause of the failure was a low battery then you should charge the battery. 
Start the TuneEdit software and wait until the message “Diagnostics disabled because 
connection failed three times” appears at the bottom of the screen.  This message will not be 
displayed if the “show running info” option is not selected in the Properties screen (in which 
case ignore this step).  Now you can try the download again.  This may work without any 
other changes but on some bikes you may need to change the “Wait Time” in the properties 
menu.   
 
If you need to change the “wait time”, change it to a number that is five higher than the 
current value and try the download.  If this does not work then try a number five lower. 
Remember to set the “wait time” back to the normal values after the download is complete. 
If the problem persists try using a different PC as differences in serial ports can cause 
problems on some PC’s. 
 
2)  If the download starts and a “timeout” message appears after the squares start to fill in on 
the progress bar, select the “Options” menu and select “Slow download mode”.  This should 
allow the download to complete without a problem. 
 
For the Keihin maps we have added a “Recover from failed download” option under Tools.  
This option will load the standard (unmodified) map into the ECU.  You must do a normal 
download after you have used this option or your map changes will no longer be in the ECU. 
If your PC has a USB port then you can use a Keyspan USB to Serial adapter (part number 
USA-19HS or USA-19QW).  This adaptor has been tested with TuneBoy and TuneEdit and 
will work on any PC.  Visit http://www.keyspan.com for details. The current price in the US is 
around $35 (as at 1.05.06).  This is the only USB-Serial device that supports the baud rates 
required to connect to the ECU. 
 
If all else fails, contact us at support@tuneboy.com.au and we will work with you to 
resolve any problems. 
 
  
Glossary 
 
Adaptive Stepper: 
Adaptive stepper is a term used to describe the algorithm used by the ECU to remember 
what it should do with the idle stepper motor. 
 
Build Information: 
The build information is information like build date and VIN. 



 
Closed Throttle Position: 
Closed throttle is when the butterflies in the throttle bodies are completely closed. 
 
CO: 
CO (Carbon monoxide) is the gas reading used to adjust the idle fuel trim.  
 
Dwell: 
Dwell is the amount of time that the ECU allows the ignition coil to charge before it triggers 
the spark. 
 
ECU: 
The Engine Control Unit is the computer on the bike that controls fuel and ignition. 
 
Engine Cycle: 
An engine cycle is a full 720 degree’s of engine rotation. 
 
Fuel Trim: 
A fuel trim is a percentage adjustment to the amount of fuel delivered. 
 
Full Load: 
Full load is different to 100% throttle.  For example, at low revs anything over about 25% 
throttle would be considered full load, at high revs it would be more like 85% throttle before 
the ECU considers the motor to be under full load. 
 
Idle Air Control Valve: 
Idle air control valve and Idle stepper are the same thing. 
 
Idle Fuel Trim: 
This is a value used to adjust the amount of fuel that the motor gets at idle and very low 
throttle settings. 
 
Idle Stepper Motor: 
The idle stepper is a small stepper motor used to control the amount of air that is allowed 
into the engine at idle, using this the ECU can control idle speed. 
 
Interpolate: 
This is the process of working out a middle value between two other values, for example if 
you have a value at 2000 RPM of 12.5 and a value at 2250 RPM of 17.0 but you want to 
know what value to use at 2100 RPM. Interpolation would come up with a value of 14.3 for 
2100 RPM. 



 
MC1000 ECU:  
All Sagem ECU equipped bikes from Mid 1999-Mid 2000 on.  This ECU has two plugs on it. 
 
MC2000 ECU:  
All T595, T509. 
Early 1999 (955i, Tiger and Sprint ST) up to mid 2000. 
 
Keihin ECU: 
Daytona 600, 650, 675, Rocket III, Rocket III Classic, 1050 Speed Triple, 1050 Sprint ST. 
   
OBDII Diagnostic Connector: 

 

 
 

This is what the connector on the bike looks like.   
OBDII stands for On Board Diagnostics Version 2.  The Triumph ECU uses OBDII as the 
connection protocol but it uses its own set of instructions to do many of the extra functions.  
 
Part Throttle: 
Part throttle is any time the ECU does not consider the motor to be under full load.   At low 
revs, part throttle will be up to about 20% throttle.  As the revs climb, so does this 
percentage.  (More information to follow with next update.) 
 
PCIII Trim Maps: 
A PCIII trim map is a map that was created for a Power Commander III fuel modifier box.  
 
Protocols: 
A protocol is like a language that computers use to talk to each other.  If one computer does 
not conform to the protocol then the other will not know what it is saying. 
 
Raw Values: 
The raw values are the actual numbers that are stored in the ECU.  When the tables are 
displayed in the software many of the values have to be adjusted so that when they are 
displayed they make sense to us. 
Example: the raw value in one of the air fuel tables could be 250, this is then divided by 20 
and displayed as displayed as 12.5 on the screen. 
 
Real Time Info: 
The real time info is the current TPS, RPM etc displayed at the bottom of the TuneEdit 
screen. 
 
RESTORE Option: 
The restore option is a feature to be added at a later date, this will allow the original tune to 
be loaded back into the ECU quickly and easily. 
 
Running Information: 
This refers to the current engine info, RPM, TPS etc. 



 
Sensor Reference: 
The sensor reference is a voltage used for all other sensors.  This value is used to tell the 
ECU what the high value is for all sensors.   
Example: if the throttle position sensor voltage is 4.9v and the sensor reference is 4.9v, the 
throttle position will be 100%. 
 
Serial Conversion Cable: 
The cable that connects the serial port on the PC to the diagnostic port on the bike. 
 
Serial Port / Communications Port (COM): 
The small nine pin plug on the back of the PC. 
 
Software/Security Key: 
The key purchased to allow the software to be used with your bike.  Also referred to as a 
TuneBoy or TuneEdit key.  These are specific to the bikes ECU. 
 
Target Idle Speed: 
The idle on the bike is controlled by a small stepper motor.  This controls the amount of air 
allowed into the motor at idle.  By adjusting the amount of air the ECU can increase or 
decrease the idle speed.  The target idle speed is the speed that the ECU will try to maintain. 
 
Throttle Offset: 
The throttle offset is the value used by the ECU to convert the uncorrected throttle position to 
a corrected throttle position.  If your throttle position is 9% when the throttle is closed then 
the ECU must subtract this 9% from the throttle position to work out how far the throttle is 
open. The throttle offset is the raw value used to represent this value.  
 
Throttle Position Sensor: 
The throttle position sensor tells the ECU how far you have opened the throttle.  The sensor 
itself returns a 0 – 5volt signal to the ECU. 
 
Wait Time: 
The wait time is a value used by the program during the start up of a connection to the ECU.  
The value is the number of milliseconds to wait (after the initial response from the ECU) 
before sending the next request.  If the program replies too early, the ECU will ignore it.  If it 
replies late, the ECU will also ignore the reply.  This value is very PC specific and at present 
needs trial and error to work out the best value. 
 



 
Tune Listing 

 

This is a list of the latest tunes released by Triumph.  Many of the Triumph tunes share a common 
program part and only differ in the map overlay that is loaded into the ECU.  This is why I have 
included a field called "Base Tune".  This is the common program code that the tune uses. 

  

Tune 
Number 

Base 
Tune Description 

9852 9852 T509 885cc Speed Triple (up to 1999 model year) with standard exhaust  
9853 9852 T509 885cc Speed Triple (up to 1999 model year) with low aftermarket exhaust  
9854 9852 T509 885cc Speed Triple (up to 1999 model year) with high aftermarket exhaust 

      
9855 9852 T595 Daytona with 108ps French engine with high aftermarket exhaust 
9856 9852 T595 Daytona with 108ps French engine with low aftermarket exhaust 
9857 9852 T595 Daytona with 108ps French engine with standard exhaust 
      
9858 9852 T595 Daytona with standard exhaust and old cam timing (with wheel sensor) 

9859 9852 T595 Daytona with low aftermarket exhaust and old cam timing (with wheel 
sensor) 

9860 9852 T595 Daytona with high aftermarket exhaust and old cam timing (with wheel 
sensor) 

      
9861 9852 T595 Daytona with standard exhaust and new cam timing (no wheel sensor) 

9862 9852 T595 Daytona with low aftermarket exhaust and new cam timing (no wheel 
sensor) 

9863 9852 T595 Daytona with high aftermarket exhaust and new cam timing (no wheel 
sensor) 

      
9888 9888 Sprint ST/RS (up to 2000 model year) with standard exhaust (without catalyst) 
9889 9888 Sprint ST/RS (up to 2000 model year) with standard exhaust (with catalyst) 

9890 9888 Sprint ST/RS (up to 2000 model year) with standard exhaust with aftermarket 
exhaust 

      
9891 9888 Tiger (up to 2000 model year) with standard exhaust  
9892 9888 Tiger (up to 2000 model year) with standard exhaust (with closed loop catalyst) 
9893 9888 Tiger (up to 2000 model year) with aftermarket exhaust 



      
9894 9894 955i Daytona (1999 model year) with standard exhaust  
9895 9894 955i Daytona (1999 model year) with high aftermarket exhaust 
9896 9894 955i Daytona (1999 model year) with low aftermarket exhaust 
      
9897 9894 955i Speed Triple (1999 model year) with standard exhaust  
9898 9894 955i Speed Triple (1999 model year) with high aftermarket exhaust 
9899 9894 955i Speed Triple (1999 model year) with low aftermarket exhaust 
      
10071 10071 Daytona up to VIN 132512 (2000-2001 model years) with standard exhaust 

10072 10071 Daytona up to VIN 132512 (2000-2001 model years) with high aftermarket 
exhaust 

10073 10071 Daytona up to VIN 132512 (2000-2001 model years) with low aftermarket 
exhaust 

      
10150 10071 955cc Speed Triple up to VIN 141871 with standard exhaust 
10075 10071 955cc Speed Triple up to VIN 141871 with high aftermarket exhaust 
10076 10071 955cc Speed Triple up to VIN 141871 with low aftermarket exhaust 
      
10150 10071 Sprint ST/RS up to VIN 139276 with standard exhaust 

10077 10071 Sprint ST/RS up to VIN 139276 with standard exhaust (with closed loop 
catalyst) 

10078 10071 Sprint ST/RS up to VIN 139276 with aftermarket exhaust 
      
10124 10071 885cc Tiger with standard exhaust  
10125 10071 885cc Tiger with standard exhaust (with closed loop catalyst) 
10126 10071 885cc Tiger with aftermarket exhaust 
      
10120 10071 955cc Tiger to VIN 206546 with standard exhaust (with or without catalyst) 
10121 10071 955cc Tiger to VIN 206546 with aftermarket exhaust 

10174 10071 955cc Tiger to VIN 206546, Brazil only, with standard exhaust (with or without 
catalyst) 

10175 10071 955cc Tiger to VIN 206546, Brazil only, with aftermarket exhaust 
      
10172 10071 955cc Tiger from VIN 206547 with standard exhaust (with or without catalyst) 
10173 10071 955cc Tiger from VIN 206547 with aftermarket exhaust 

10176 10071 955cc Tiger from VIN 206547, Brazil only, with standard exhaust (with or 
without catalyst) 

10177 10071 955cc Tiger from VIN 206547, Brazil only, with aftermarket exhaust 
      



10178 10152 Daytona from VIN 132513 with standard exhaust  

10179 10152 Daytona from VIN 132513 with aftermarket exhaust when secondary air 
injection is fitted 

10180 10152 Daytona from VIN 132513 with standard exhaust when secondary air injection is 
fitted 

10181 10152 Daytona from VIN 132513 with aftermarket exhaust 
      
10088 10088 TT600 up to VIN 115673 with standard exhaust 
10089 10088 TT600 up to VIN 115673 with aftermarket exhaust 
      
10090 10090 TT600 from VIN 115674 to 136915 with standard exhaust 
10091 10090 TT600 from VIN 115674 to 136915 with aftermarket exhaust 
      
10152 10152 955cc Speed Triple from VIN 141872 to 147920 with standard exhaust 

10153 10152 955cc Speed Triple from VIN 141872 to 147920 with standard exhaust and 
secondary air injection fitted 

10154 10152 955cc Speed Triple from VIN 141872 to 147920 with aftermarket exhaust 

10155 10152 955cc Speed Triple from VIN 141872 to 147920 with aftermarket exhaust with 
secondary air injection 

      
10156 10152 955cc Speed Triple from VIN 147921 to 207554 with standard exhaust 

10157 10152 955cc Speed Triple from VIN 147921 to 207554 with standard exhaust and 
secondary air injection fitted 

10158 10152 955cc Speed Triple from VIN 147921 to 207554 with aftermarket exhaust 

10159 10152 955cc Speed Triple from VIN 147921 to 207554 with aftermarket exhaust and 
secondary air injection fitted 

      
10168 10152 955cc Speed Triple from VIN 207555 with standard exhaust 

10169 10152 955cc Speed Triple from VIN 207555 with standard exhaust and secondary air 
injection fitted 

10170 10152 955cc Speed Triple from VIN 207555 with aftermarket exhaust 

10171 10152 955cc Speed Triple from VIN 207555 with aftermarket exhaust and secondary 
air injection fitted 

      
10156 10152 Sprint ST/RS from VIN 139277 to 207554 with standard exhaust 

10157 10152 Sprint ST/RS from VIN 139277 to 207554 with standard exhaust and secondary 
air injection fitted 

10158 10152 Sprint ST/RS from VIN 139277 to 207554 with aftermarket exhaust 

10159 10152 Sprint ST/RS from VIN 139277 to 207554 with aftermarket exhaust and 
secondary air injection fitted 

      
10168 10152 Sprint ST/RS from VIN 207555 with standard exhaust 



10169 10152 Sprint ST/RS from VIN 207555 with standard exhaust and secondary air 
injection fitted 

10170 10152 Sprint ST/RS from VIN 207555 with aftermarket exhaust 

10171 10152 Sprint ST/RS from VIN 207555 with aftermarket exhaust and secondary air 
injection fitted 

      
10166 10164 TT600 from VIN 136916 with standard exhaust 

10165 10164 TT600 from VIN 136916 with standard exhaust with secondary air injection 
fitted 

      
10167 10164 Speed 4 with standard exhaust 
10164 10164 Speed 4 with standard exhaust with secondary air injection fitted 

   

  

  

  

 

This is a list of every tune we currently have for the Keihin ECU: 

Tune 
Number 

Base 
Tune Description 

    To VIN 182233 with 16 tooth output sprocket  
20024 20024 Daytona 600 with standard exhaust and secondary air injection  
20025 20024 Daytona 600 with standard exhaust  
20026 20024 Daytona 600 French 78.1KW restricted  
20027 20024 Daytona 600 German 72.1KW restricted  
20028 20024 Daytona 600 with aftermarket exhaust and secondary air injection  
20029 20024 Daytona 600 with aftermarket exhaust  
    From VIN 182234 to 201541 with 15 tooth output sprocket  
20030 20024 Daytona 600 with standard exhaust and secondary air injection  
20031 20024 Daytona 600 with standard exhaust  
20032 20024 Daytona 600 French 78.1KW restricted  
20033 20024 Daytona 600 German 72.1KW restricted  
20034 20024 Daytona 600 with aftermarket exhaust and secondary air injection  
20035 20024 Daytona 600 with aftermarket exhaust  



    From VIN 201542 with 15 tooth output sprocket  
20057 20024 Daytona 600 with standard exhaust and secondary air injection  
20058 20024 Daytona 600 with standard exhaust  
20059 20024 Daytona 600 French 78.1KW restricted  
20060 20024 Daytona 600 German 72.1KW restricted  
20061 20024 Daytona 600 with aftermarket exhaust and secondary air injection  
20062 20024 Daytona 600 with aftermarket exhaust  
    All VIN's  
20063 20024 Daytona 650 with standard exhaust and secondary air injection  
20064 20024 Daytona 650 with standard exhaust  
20065 20024 Daytona 650 French 78.1KW restricted  
20066 20024 Daytona 650 German 72.1KW restricted  
20067 20024 Daytona 650 with aftermarket exhaust and secondary air injection  
20068 20024 Daytona 650 with aftermarket exhaust  
    All VIN's  
20145 20145 Rocket III with standard pipe and catalyst  
20150 20145 Rocket III with standard pipe (No catalyst)  
20146 20145 Rocket III French 78.1KW restricted  
20147 20145 Rocket III German 72.1KW restricted  
20148 20145 Rocket III with aftermarket exhaust and catalyst  
20151 20145 Rocket III with aftermarket exhaust (No catalyst)  
20149 20145 Rocket III with aftermarket exhaust with cat box removed  

20050_1 20050 Rocket III with Staintune exhaust, Staintune cat eliminator, full power in all 
gears and speedo corrected  

20050_2 20050 Rocket III with Triumph off road pipes, cat box eliminator, full power in all 
gears and speedo corrected  

20050_3 20050 Rocket III with Triumph off road pipes, cat box eliminator, full power in all 
gears, speedo corrected and TuneBoy pod air filters  

20145_1 20145 Rocket III with Jardines full system, full power in all gears, speedo corrected and 
TuneBoy pod air filters  

    All VIN's  
20138 20145 Rocket III classic with standard pipe and catalyst  
20139 20145 Rocket III classic French 78.1KW restricted  
20140 20145 Rocket III classic German 72.1KW restricted  
20141 20145 Rocket III classic with aftermarket exhaust with catalyst  
20142 20145 Rocket III classic with aftermarket exhaust with cat box removed  
20143 20145 Rocket III classic with standard pipe, without catalyst  
20144 20145 Rocket III classic with aftermarket exhaust, without catalyst  
    To VIN 281465   
20100 20101 1050cc Speed Triple with standard exhaust with catalyst and secondary air 



injection  
20101 20101 1050cc Speed Triple with standard exhaust  

20102 20101 1050cc Speed Triple with aftermarket exhaust with catalyst and secondary air 
injection  

20103 20101 1050cc Speed Triple with aftermarket exhaust  
20133 20101 1050cc Speed Triple with Arrow exhaust and secondary air injection  
20134 20101 1050cc Speed Triple with Arrow exhaust  
    To VIN 281465   
20104 20101 1050cc Sprint ST with standard exhaust with catalyst and secondary air injection 
20105 20101 1050cc Sprint ST with standard exhaust  

20106 20101 1050cc Sprint ST with aftermarket exhaust with catalyst and secondary air 
injection  

20107 20101 1050cc Sprint ST with aftermarket exhaust  
    To VIN 294377  
20108 20108 Daytona 675 with standard exhaust  
20109 20108 Daytona 675 with aftermarket exhaust  
20110 20108 Daytona 675 with Arrow aftermarket exhaust system  
    From VIN 281466 to 305059 (Plastic tank)  

20111 20111 1050cc Speed Triple with standard exhaust with catalyst and secondary air 
injection  

20112 20111 1050cc Speed Triple with aftermarket exhaust  
20115 20111 1050cc Speed Triple (Brazil only)  
20116 20111 1050cc Speed Triple (Brazil only) with aftermarket exhaust  

20127 20123 1050cc Speed Triple with standard exhaust without catalyst and secondary air 
injection  

20128 20123 1050cc Speed Triple with aftermarket exhaust without catalyst and secondary air 
injection  

20131 20123 1050cc Speed Triple with Arrow exhaust with secondary air injection  
20132 20123 1050cc Speed Triple with Arrow exhaust without secondary air injection  
    From VIN 305060 (Steel tank)  
20173 20169 1050cc Speed Triple with standard exhaust, With secondary air injection  
20174 20169 1050cc Speed Triple with aftermarket exhaust, With secondary air injection  
20177 20169 1050cc Speed Triple (Brazil only)  
20178 20169 1050cc Speed Triple (Brazil only) with aftermarket exhaust  
20169 20169 1050cc Speed Triple with standard exhaust without secondary air injection  
20170 20169 1050cc Speed Triple with aftermarket exhaust without secondary air injection  
20181 20169 1050cc Speed Triple with Arrow exhaust with secondary air injection  
20182 20169 1050cc Speed Triple with Arrow exhaust without secondary air injection  
    From VIN 281466  
20113 20111 1050cc Sprint ST with standard exhaust with catalyst and secondary air injection 



20114 20111 1050cc Sprint ST with aftermarket exhaust with catalyst and secondary air 
injection  

20117 20111 1050cc Sprint ST (Brazil only) with standard exhaust  
20118 20111 1050cc Sprint ST (Brazil only) with aftermarket exhaust  

20129 20123 1050cc Sprint ST with standard exhaust without catalyst and secondary air 
injection  

20130 20123 1050cc Sprint ST with aftermarket exhaust without catalyst and secondary air 
injection  

    All VIN's  
20157 20123 1050cc Tiger with standard exhaust with catalyst and secondary air injection  
20158 20123 1050cc Tiger with aftermarket exhaust with catalyst and secondary air injection  
20159 20123 1050cc Tiger with standard exhaust without catalyst and secondary air injection  

20160 20123 1050cc Tiger with aftermarket exhaust without catalyst and secondary air 
injection  

20161 20123 1050cc Tiger (Brazil only) with standard exhaust  
20162 20123 1050cc Tiger (Brazil only) with aftermarket exhaust  
    From VIN 294378  
20135 20108 Daytona 675 with standard exhaust  
20136 20108 Daytona 675 with aftermarket exhaust  
20137 20108 Daytona 675 with Arrow aftermarket exhaust system  
20119 20108 Daytona 675 (Brazil only) with standard exhaust  
20120 20108 Daytona 675 (Brazil only) with aftermarket exhaust  

   

  

  

 

This is a list of the tunes we currently have for the KTM's using the Keihin ECU. 

Tune Name Description 
  2005/2006 SuperDuke  
KM610EU050E001 990 SuperDuke, standard pipes  

KM610AK050E002 990 SuperDuke, Akrapovic slip on pipes (Off road use only, Not using O2 
sensor)  

KM610AK0503D03 990 SuperDuke, Akrapovic slip on pipes  

KM610AK050E002M 990 SuperDuke,Dyno tuned with standard pipes  (Off road use only, Not using 
O2 sensor)  



KM610AE0503D01 990 SuperDuke, Evo full exhaust system (Off road use only, Not using O2 
sensor)  

  2007 SuperDuke  
KM611EU0704530 990 SuperDuke, standard pipes Europe  
KM611US0704530 990 SuperDuke, standard pipes USA  
KM611FR0704530 990 SuperDuke, standard pipes France  
  990 Adventure  
KM601EU0603D01 990 Adventure, standard pipes  
KM601AK0603D01 990 Adventure, Akrapovic slip on pipes  

   

  

  

  

 

This is a list of every tune we currently have for the Benelli Tre 900 using the Sagem ECU. 

Tune 
Number 

Base 
Tune Description 

6011 6011 Tornado factory tune for US bikes  
6012 6012 Tornado tune for Bi Posto (2002)  
6016 6016 Tornado tune for Bi Posto (2002) Mid  
6020 6020 Tornado tune for Tornado RS 
6027 6027 Tornado tune for Tornado RS 
6030 6030 Tornado tune for Tornado RS 
6033 6033 Tornado tune for Tornado RS 
6033AF 6033 Tornado tune for Tornado RS with aftermarket pipe fitted (Dyno tuned) 
6033STD 6033 Tornado tune for Tornado RS with standard pipe fitted (Dyno tuned) 
6034 6034 Tornado tune for Tornado RS 
6007AF 6007 Tornado tune for Tornado series oro with after market pipe fitted (Dyno tuned) 
6007STD 6007 Tornado tune for Tornado series oro with standard pipe fitted (Dyno tuned) 
6103 6103 Tornado tune for Tornado RS (2003) 
6105 6105 Tornado tune for Tornado RS (2003)  

   

This is a list of every tune we currently have for the Benelli 1130 TNT using the Walbro ECU. 



Tune 
Number 

Base 
Tune Description 

TNT05AN02 N/A TNT factory tune  

   

  

  

  

  

   

  

  

  

 

This is a list of every tune we currently have for the Aprilia's using the Sagem ECU. 

Tune 
Number 

Base 
Tune Description 

790412 790412 RST Futura, 2001 Mapping.  
180901 180901 RST Futura, 2002 Mapping.  
120401 120401 RST Futura, 2003 Mapping.  
      
790329 790329 Caponord Tune build date(29 Mar 2001)  
921123 921123 Caponord Tune build date(22 Nov 2001)  
020108 020108 Caponord Tune build date(08 Jan 2002)  
050115 050115 Caponord Tune build date(15 Jan 2003)  
050428 050428 Caponord Tune build date(28 Apr 2003)  

 

This is a list of every tune we currently have for the Aprilia's using the Walbro ECU. 

Note: You should download V3.2.6 of TuneEdit to use the latest tunes. 



Tune 
Number 

Base 
Tune Description 

24020 24007 RXV 450 with standard exhaust  
24009 24009 RXV 450 with Termignoni exhaust  
24010 24010 RXV 450 with Silmotor exhaust  
24021 24011 RXV 450 with standard exhaust (US market)  
24022 24012 RXV 450 with standard exhaust (Japan market)  
24023 24013 RXV 450 with Akrapovic exhaust  
      
14018 14008 SXV 450 with standard exhaust  
14009 14009 SXV 450 with Termignoni exhaust  
14021 14010 SXV 450 with Silmotor exhaust  
14019 14011 SXV 450 with standard exhaust (US market)  
14020 14012 SXV 450 with standard exhaust (Japan market)  
      
25016 25005 RXV 550 with standard exhaust  
25007 25007 RXV 550 with Silmotor exhaust  
25017 25008 RXV 550 with standard exhaust (US market)  
25018 25009 RXV 550 with standard exhaust (Japan market)  
25019 25010 RXV 550 with Akrapovic exhaust  
      
15017 15007 SXV 550 with standard exhaust  
15008 15008 SXV 550 with Termignoni exhaust  
15020 15009 SXV 550 with Silmotor exhaust  
15018 15010 SXV 550 with standard exhaust (US  market)  
15019 15011 SXV 550 with standard exhaust (Japan market)  

 


